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1. Introduction to Kernel for Publisher

Welcome to the user manual for Kernel for Publisher, the most effective and convenient .pub file repair tool 
available that repairs corrupt or damaged MS Office Publisher documents. This user manual comprises 
step by step guidelines on using Kernel for Publisher. 

1.1  Using this Manual 

This user manual is intended to guide users on using Kernel for Publisher. We suggest that first time users 
should read this user manual completely and carefully before proceeding to use the software. However, if 
you are an experienced user, you can use the table of contents to find out information pertaining to the 
tasks that you need to perform by using Kernel for Publisher. 

You can use the table of contents to navigate through different sections of this user manual. The table of 
contents lists all the sections that are contained in this user manual in chronological order. The user 
manual comprises the following sections: 

 Introduction

 Getting Started

 Software Interface

 Repairing .PUB Files

 Full Version

 Support

 Troubleshooting

 Legal Notices

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of 
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual. 

1.1.1 List of Abbreviations 

MS: Microsoft 

PUB: Publisher file 

RAM: Random Access Memory 

MB: Mega-Byte 

GB: Giga-Byte 
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1.2  About Kernel for Publisher 

Kernel for Publisher is file repair and data recovery software for MS Office Publisher. This software repairs 
MS Office Publisher document files that become inaccessible due to unexpected system shutdown, power 
failure, virus attacks, media errors, software crash etc. 

You might be familiar with the following error messages if you have encountered MS Office Publisher .pub 
file corruption before: 

 “Publisher unable to open file”

 “Cannot update object”

 General Input/output error

 File link error message on opening Publisher

Kernel for Publisher quickly and effectively resolves the above mentioned errors by repairing corrupt .pub 
file, keeping the complete document format intact. It restores images, drawing objects, word art, text, and 
all other components of the corrupt Publisher document. 

1.3 Salient Features 

Salient features of Kernel for Publisher include: 

 Powerful design recovery tool for corrupt Publisher file which recovers graphics, data, word art, and art
images

 Support for all versions of MS Office Publisher – Publisher 2000, 2002, 2003

 User friendly graphical user interface, no technical skills required

 Saves file in RTF (Rich Text format) and PUB format

 Free demo to test the capabilities of the tool before purchasing it

1.4 Who Should Use this Software? 

The capability of Kernel for Publisher to repair corrupt .pub files makes it appropriate for use by every 
professional who works on the designing tool – MS Publisher. The software proves beneficial to the 
publishing industry, designing experts, and small business owners as well. 

The software easily repairs the damaged/corrupt marketing material, websites, calendars, greeting cards, 
postcards, business cards, brochures, and much more. This corruption could have been caused due to 
virus attacks, improper system shutdown, installation of unsupported software, software crash etc. 
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2. Getting Started

Now that you have understood the features and potential of Kernel for Publisher, you are ready to get a 
hand on experience of the software. To start repairing .pub files, you will first need to download and install 
this software.  

It is strongly recommended that before installing Kernel for Publisher, you should go through the 
installation pre-requisites for the software to ensure that your computer is appropriately configured to run 
the software. 

2.1 Installation Pre-requisites 

The various pre-requisites for installing and running Kernel for Publisher can be broadly classified into two 
major categories – Hardware requirements and Software requirements. 

2.1.1 Hardware Requirements: 

The hardware requirements for installing the software are as follows: 

 Pentium Class Processor

 Minimum 64MB RAM (128 MB recommended)

 10MB for Software installation

 Disk Space - Enough space to store the repaired files

 You should have at-least 10 MB of free disk space if you want to repair and save a 
10 MB .pub file. 

2.1.2 Software Requirements: 

The software requirements for installing the software can be further grouped into two categories – 
Operating System requirements and MS Office version requirements. The requirements are as follows: 

2.1.2.1 Operating System Requirements 

Supported Operating Systems: 

 Windows Vista

 Windows 2003

 Windows XP

 Windows 2000

 Windows NT
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 Windows 98

 Windows 95

2.1.2.2 MS Publisher Version Requirements 

Supported MS Office Publisher versions: 

 Publisher 2003

 Publisher 2002

 Publisher 2000

2.2 Downloading Kernel for Publisher for the First Time 

After checking your computer with the prescribed system requirements for Kernel for Publisher, you can 
download and install the software on your computer. You can buy the full version of the software from any 

one of our authorized resellers– Element5, Asknet, and 2CO. 

If you want to try using Kernel for Publisher before buying it, you can download the evaluation version from 
the following link: 

https://www.nucleustechnologies.com/publisher-recovery.html

 You can repair .pub files saved on your system by using the evaluation version of 
Kernel for Publisher; however, to save the repaired file you need to purchase the full 
version of the software. 

2.3 Install Kernel for Publisher 

After downloading the installer file for Kernel for Publisher, you can install the software by running the file. 
To install Kernel for Publisher: 

1. Double-click the Kernel for Publisher installer. Follow the on-screen instructions.

The Setup Installation Complete screen will be displayed. 

2. Click the Finish button to launch the software.

2.4 Start Kernel for Publisher 

To start Kernel for Publisher: 

Click Start  All Programs Kernel for Publisher 

Alternatively, you can launch Kernel for Publisher by double-clicking the shortcut icon available on the 
Desktop and Quick Launch icon. 

2.5 Uninstall Kernel for Publisher 

https://www.nucleustechnologies.com/Download-Publisher-Recovery.php


© KernelApps Private Limited

You may need to uninstall Kernel for Publisher. To uninstall Kernel for Publisher: 

1. Click Start  All Programs Kernel for Publisher  Uninstall Kernel for Publisher. A warning
message will be displayed.

2. Click ‘Yes’ to uninstall Kernel for Publisher.

 Before proceeding to uninstall Kernel for Publisher, you must ensure that the 
software is not running in system background. 

You can alternatively uninstall Kernel for Publisher from Control Panel by performing the following steps: 

1. Click Start  Control Panel and then double click the Add or Remove Programs icon.

2. Select Kernel for Publisher and click Remove.

A warning message will be displayed. 

3. Click the Yes button to uninstall Kernel for Publisher.
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3. Software Interface

Now that Kernel for Publisher has been installed on your computer, you can start using the software after 
getting acquainted with the software interface. 

3.1 Menu Bar 

The Menu bar of Kernel for Publisher comprises three main menus – File, Tools, and Help. 

3.1.1 File Menu 

The File menu comprises three menu items. 

Figure 3.1: File Menu 

Menu items in the File menu: 

Field Name Field Description 

Add Adds the corrupt publisher file for repairing 

Save Saves the repaired file 

Exit Exists the software 

3.1.2 Tools Menu 

The Tools menu comprises two menu items. 

Figure 3.2: Tools Menu 

Menu items in the Tools menu: 
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Field Name Field Description 

Setting Changes the prefix of the repaired file name 

Live Update Helps to get the latest version of the software 

3.1.3 Help Menu 

The Help menu comprises three menu items. 

Figure 3.3: Help Menu 

Menu items in the Help menu: 

Field Name Field Description 

Help Displays help information for performing various tasks 
using Kernel for Publisher 

Software Homepage Displays the software homepage on our website 

About Kernel for Publisher Displays the software version and support related 
information 

3.2 Tool Bar 

The Tool bar in Kernel for Publisher is displayed below the Menu bar. The Tool bar provides a convenient 
and user-friendly method to perform certain actions that can also be performed by using the Menu bar. 
Read the information in the table below to find out about the Tool bar buttons: 

Button Button Name Button Description 

Add Files Adds the corrupted Publisher file 
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Repair Files Repairs the selected file 

Save Files Saves the Repaired file 

Settings Changes the file name prefix 

Live Update Helps to get the latest version of the software 

Buy Online Opens the software website page for online 
software purchase 

3.3 Buttons Used 

Apart from the standard options available in the Menu bar and the Tool bar, following are the other main 
buttons used in the software: 

Browses the .pub file that needs to be repaired 

Starts the repairing process 

Takes you back to the previous screen 

Stops the repairing process 
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4. Repairing .PUB Files

Now that you have familiarized with the user interface of Kernel for Publisher, you are ready to repair .pub 
files. 

To repair .pub files: 

1. Launch Kernel for Publisher.

Figure 4.1: Main Window: Kernel for Publisher 

2. Click the Add Files button to browse and select corrupt .pub files.
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Figure 4.2: Select File to Repair 

3. Click the Next button to start with the .pub file repairing process. After you click the Next button, the
software asks you to define the location to save the repaired file.
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Figure 4.3: Repairing Process Status 

4. Browse to your desired location and click the OK button.

As soon as the Kernel for Publisher finishes the repairing and saving process, it displays the message 
‘Files saved successfully’.  

5. Click the OK button to exit the software.
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5. Full Version

Although you can use Kernel for Publisher evaluation version for free and experience the capabilities of 
the software, there are certain features that are not available in the evaluation version. 

5.1 Requirement of Full Version 

By using the evaluation version of Kernel for Publisher, you can repair corrupt .pub files; however, you 
cannot save the repaired files. 

You will need to buy the full version of the software to save the repaired .PUB files. 

5.2 Purchasing Full Version 

You can buy the full version of Kernel for Publisher from any one of our authorized resellers – Element5, 
Asknet, and 2CO. 

As soon the purchase transaction with our resellers gets completed, our sales team will send you an email 
comprising the URL to download the full version of Kernel for Publisher and activation details of the 
software. 

5.3 Support 

We have an extensive and efficient support system in place to assist our customers with all issues related 
to using Kernel for Publisher. The software comes with an embedded help manual that can be accessed 
by clicking Help  Help in the Menu bar. You can also press the F1 key on the keyboard of 
your computer to access the embedded help of Kernel for Publisher. 

We have live support wherein you can chat with our software experts at 

https://www.nucleustechnologies.com/supportcenter/

To talk on phone with our software experts call: 

Help line:  

+91-9818725861

1-866-348-7872 (Toll Free for USA/CANADA)

You can also email us about your queries at: 

sales@nucleustechnologies.com for Sales 

http://www.nucleustechnologies.com/supportcenter/
mailto:sales@nucleustechnologies.com
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support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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6. Troubleshooting

This section deals with your generic and specific queries pertaining to using Kernel for Publisher. 

6.1 Common Issues 

Why does Kernel for Publisher have limitations in evaluation copy? 

The free evaluation version of Kernel for Publisher is intended to enable you to experience the capabilities 
of the software. You will need to buy the software to save the repaired .pub files. 

6.2 Frequently Asked Questions 

How to Buy Kernel for Publisher? 

You can buy Kernel for Publisher online at https://www.nucleustechnologies.com/Buy-
Publisher-Recovery.php 

I have lost my full version for Kernel for Publisher. Can you help me? 

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address, 
and order confirmation number (if you have it). We will be happy to help you. 

https://www.nucleustechnologies.com/Buy-Publisher-Recovery.php
https://www.nucleustechnologies.com/Buy-Publisher-Recovery.php
mailto:sales@nucleustechnologies.com
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7. Legal Notices

This section comprises the legal specification about Kernel for Publisher and the company 
KernelApps Private Limited 

7.1 Copyright 

KernelApps Private Limited, KernelApps accompanied user manual and documentation are copyright of 
KernelApps Private Limited, with all rights reserved under the copyright laws. This user manual cannot 
be reproduced in any form without the prior written permission of KernelApps Private Limited. No 
Patent Liability is assumed; however, with respect to the use of the information contained herein. 

© KernelApps Private Limited. All rights reserved. 

7.2 Trademark 

KernelApps ® is a copyright work of KernelApps Private Limited 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista, MS-DOS, and MS Office are 
registered trademarks of Microsoft Corporation. 

All other brand and product names are trademarks or registered trademarks of their respective companies. 

7.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. KernelApps Private Limited provides no warranty with regard to this manual or 
any other information contained herein and here by expressly disclaims any implied warranties of 
merchantability or fitness for any particular purpose with regard to any of the foregoing. 
KernelApps Private Limited assumes no liability for any damages incurred directly or indirectly from any 
technical or typographical errors or omissions contained herein or for discrepancies between the 
product and the manual. In no event shall KernelApps Private Limited, be liable for any 
incidental, consequential special, or exemplary damages, whether based on tort, contract or otherwise, 
arising out of or in connection with this manual or any other information contained herein or the use there 
of. 

7.4 License Agreement 

Kernel for Publisher Copyright © by KernelApps Private Limited 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing, or distributing 
this software, unless you have a different license agreement signed by KernelApps Private Limited. 
The terms and conditions of this License describe the permitted use and users of each Licensed 
Copy of Kernel for Publisher. For purposes of this License, if you have a valid license, you have the right 
to use a single Licensed Copy of KernelApps. 
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Scope of License 

Each Licensed Copy of Kernel for Publisher may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. 
All rights of any kind in KernelApps, which are not expressly granted in this License, are entirely and 
exclusively reserved to and by KernelApps Private Limited. You may not rent, lease, modify, translate, 
reverse engineer, decompile, disassemble, or create derivative works based on, KernelApps, nor permit 
anyone else to do so. You may not make access to KernelApps available to others in connection with a 
service bureau, application service provider, or similar business, nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Kernel for Publisher, and any and all accompanying software, files, data, and materials, are 
distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. In 
particular, there is no warranty for the quality of data recovered. You acknowledge that good data 
processing procedure dictates that any program, including KernelApps, must be thoroughly tested 
with non-critical data before there is any reliance on it, and you hereby assume the entire risk of all use of 
the copies of KernelApps covered by this License. This disclaimer of warranty constitutes an essential part 
of this License. In addition, in no event does KernelApps Private Limited authorize you or anyone 
else to use Kernel for Publisher in applications or systems where Kernel for Publisher failure to 
perform can reasonably be expected to result in a significant physical injury, or in loss of life. Any such 
use is entirely at your own risk, and you agree to hold KernelApps Private Limited harmless from any and 
all claims or losses relating to such unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter, 
and merges and supersedes all other or prior understandings, purchase orders, agreements, 
and arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction 
and venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, 
and you consent to such jurisdiction and venue. There are no third party beneficiaries of any 
promises, obligations, or representations made by KernelApps Private Limited herein. 

Any waiver by KernelApps Private Limited of any violation of this License by you shall not constitute, nor 
contribute to, a waiver by KernelApps Private Limited of any other or future violation of the same 
provision, or any other provision, of this License. 




